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Automation with Excel Pivot
Tables

Teksouth Tips and Tricks

By Pamela Dvirnak




s TEK Problem Statement

Time is wasted daily

Downloading the same data
and
Formatting the same report




ATEKSOUTH Goal

AUTOMATE

» Use Excel Pivot Tables (and Power Query) to automate the process
* Spend your precious time analyzing data and actually doing your job
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ATEKSOUTH Objectives
B —

Download data
Connect to data
Transform data
Create Pivot Table
Create Pivot Chart
Refresh Data
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Objective 1

Download Data
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ATEKSOUTH 1 - Download Data
S —

* CRIS — 7 new perspectives to be released soon

* Consolidated Transaction Register (CTR)
* Combined DEAMS, BQ, AFM and EFD transactional data

Create New Data Source
+ L L
CREATE NEW DATASOURCE Import Datasource File(s) Import Legacy File

Perspective

-- Select a perspective --

-- Select a perspective --
ABIDES 1002

AFMSum

AFMTrans

AFSAT

Combined STH CPAS Trans
Consolidated Transaction Register (CTR)
CPAS

CPAS Hist Authority

CPAS Hist DocSum

CPAS Hist Transactions
CPAS Transactions

CTR FAD Balance

CTR Open Commitments
CTR Open Documents
CTR Open Travel

CTR Summary

DBT (Field Site EOM)
DEAMS GL

DSR (Field Site ODL)

8/21/2023 Footer 6
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ATEKSOUTH 1 - Download Data
S —

* Export Data as excel

 Save in folder
* Don’t put dates / specifics in file name
* Don’t save in folder particular to a certain FY or month
 Standardize so that links don’t have to be fixed every year / month / day

* Don’t open or change this file

@ save A X
T™ « Windows (C) » Daily SOF » 001 _Data v 9] £ Search 001_Data
Organize New folder N 0
No items match your search
wwwwww N
File name: | CTRxlsx
>
Save as type: Microsoft Excel Worksheet (*.xlsx)

260 ted
2100 7T

 Hide Folders Cancel

» Keyboard Shortcut: CTL + Shift + N = New Folder

8/21/2023 Footer
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Objective 2

Connect to Data




ATEKSOUTH 2 - Connect to data

* Create new Excel workbook

e Will use this workbook to connect to the data and make our
changes/create our pivot tables

« T ws () °
‘‘‘‘‘‘‘ Daily SOF
- View >
e ; Home Share Wiew
ET B -
. &« v » This PC » Windows (C) » Daily SOF
> ras
eeeeeeeee L Name Date modified
i 001 Data 1/17/2023 12:
o @ Pam's Daily Status of Funds.xsx 11772023 12

8/21/2023 Footer
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ATEKSOUTH 2 - Connect to data
S —

Office 365 & 2019

* Date Tab on Ribbon > Get Data > From File > From Excel Workbook

Pam's Daily Status of Funds.xlsx v

File Home Insert Page Layout Formulas Data Review \
EE I:L|§| From Text/CSV E:@q From Picture v D}‘ CHaueries & Connectio
From Web Recent Sources ~/
Get [é [5) Refresh []
Data v % From Table/Range [‘f\j Existing Connections All v [A
nnections
From File > I:E From Excel Workbook
| ) 87 o
I:% From Database 2 [I% From Text/CSV

8/21/2023 Footer
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ATEKSOUTH 2 - Connect to data
S —

Office 2016

* Date Tab on Ribbon > New Query > From File > From Workbook

I:l Show Queries (2] Connections al I3
= c L
D From Table & |:2| Properties
. . MNew Refresh zl E
File Home Insert Page Layout Formulas Data Revi Query~ (% Recent Sources All- | Edit Links A
|:| Show Queries
% [% [E @ D FD 3 From File r From Workbook
— D From Table
From From From From Other Existing Mew .
Access Web  Text  Sources-  Connections Query - [% Recent Sources From Database r _E From CSV
Get External Data Get & Transform o -
_[:1- From Azure 4 Il From XML
o= L
__3 From Other Sources » _E From Text

& Combine Queries 4 = From Folder

E} Data Source Settings...
Cluery Options

8/21/2023 Footer 1



ATEKSOUTH 2 - Connect to data

Select the file you saved previously
Click Import

Select Tablel
Click ‘“Transform Data’ (‘Edit’ in Office 2016)

Navigator

L at
¥ Import Data x [
Select multiple items AMJADSN  Appropristion A e pesems CCAC/ESP  Comm
- * 4 1 » ThisPC > Windows (C) > Dally SOF 5> 001_Data v O arch 001_Data .
Display Options = a3 | | e 3400
Organize = New folder - ™ @ mulf 3400 il
4 W CTRaksx (2]
1 Dvimak Family A N Dete iodifisd . B 387700 3400 nal
% 5 = 187700 3400 null
1 New Shooting Sport 81 TRl 216 PM  Mierosaft Excel W, CTR 0
Procf t 387700 3400 nall
Top 320 Ringtones IHFIO0 400, mall
8700 3400 [
@ OneDrive mal
387700 3400 CivPay
@ OneDrive - Teksouth Corperation 387700 3400 1 CivPay
™ This PC O he dat . b
- Google Drive (G)
- USB Drive (5))
o USB Drive @)
- USE Drive (5)) v € >
File name: |CTRdsx | el Files ("% xls* s * s <

>

losd | I:udnﬂ Dats

8/21/2023 Footer



ATEKSOUTH
T

Objective 3

Transform Data




TEKSOUTH 3 - Transform data

* Fix the data types in Power Query
* Select all text columns (AAI/ADSN to Period Name)
* Home Tab > Data Type Drop down menu > Select ‘Text’
* Click Replace Current

= | Table1 - Power Query Editor

Home Transform Add Column View
[ Properties L XY, X 4 T o |pataTypeany~ [ Merge Queries ~ D [ New Source
A = =
&7 [} Advanced Editor X HH HH zl Decimal Number 7 Append Queries o] [ Recent Sources ~
Refresh - . Choose  Remove Keep Remove Split  Group. . Manage Data source - - =
Preview ~ £ Manage Columns ~ Columns~  Rows ™ Rows ~ Column~ By Currency L CemiEmerts Parameters~  settings Eptegbata umn iype
Query Manage Columns ReduceRows  Sort Whole Nurnber Combine Parameters  Data Sources New Query §
Percentage
I < fe | - Table.TransformColumnTypes (Tablel_ 64.Type}, {"Appropriation”, Int6d.Type}, {"BA", Int64.Type}, {"Commodity”, type text}, {"Cost Center/R The selected column has an exsting type comversion, Would you like
Date/Time
slet — = = =
. Legacy [~ pecoeams v | A PECTI e ~ || #c saG [~ | source [~ [ system - A Period Name -] to replace the existing conversion, or preserve the existing conversion
1 = Time null AFM Legac AUG-FY-22
(. ! ey and add the new conversion as a separate step?
2 - Date/Time/Timezone null AFM Legacy AUG-FY-22
3 - Duration null AFM Legacy JUL-FY-22
4 - Text null AFM Legacy JUN-FY-22
5 - null AFM Legacy SEP-FY-22 Heplace ofqent Add rew s Cancel
— True/False
6 = null AFM DEAMS JUL-FY-22
— Binary
7 - null AFM DEAMS MAY-FY-22
8 - null AFM DEAMS OCT-FY-22
9 null AFM DEAMS SEP-FY-22

Footer
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Objective 4

Create a Pivot Table




ATEKSOUTH 4 - Create Pivot Table
S,

* Home > Close & Load Drop Down Arrow > Close & Load To...

Home Transform
P EE’D Properties
[ © 3 Advanced Ed
D‘“‘ﬂ‘ vanced E
Close & Refresh |:|
Load ~ Freview ™ hanage
a—j Close & Load ‘

’E—a Close & Load To..

* We want to only insert a Pivot Table

 \We do not want a table

8/21/2023 Footer



ATEKSOUTH 4 - Create Pivot Table

Microsoft 365

Import Data ? X

Select how you want to wiew this data in your workbook,

E O Table

(®) pivotTable Report

I O PivotChart

D O Only Create Connection
Where do you want to put the data?

O Existing worksheet:

| =$A$1 El

@ Mew worksheet

DéAdd this data to the Data Mode|§

Cancel

Properties.. - QK

Footer
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ATEKSOUTH 4 - Create Pivot Table

T IIIm——,
Office 2016

Load To

Select how you want to view this data in your workbook.

E O Table
e Only Create Connection

Select where the data should be loaded.

& MNew workshest

|| Add this data to the Data Model

Load Cancel

Footer
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ATEKSOUTH 4 - Create Pivot Table

Office 2016
* Create a new worksheet > Insert Ribbon Tab > PivotTable

e Use an external data source > Choose Connection
* Select connection > open

L Existing Connections ? X
Create PivotTable ? X
Insert G

— b i Choose the data that you want to analyze Select a Connection or Table
| | ErJ | (O select a table or range Connections Tables
L | —3 == L =
] Tabl : Show: | All Connections v
YwvotTable Recommended Table Pi Table/Range s

Connections in this Workbook ~

PivotTables (®) Use an external data source
- - Query - Table1

Tables

Connection to the Table1" query in the

Connection name; Connection files on the Network

Use this workbook's Data Model <No connections found>
: Connection files on this computer
Choose where you want the PivotTable report to be placed X . P
1Exp_AFM_Engine Th_AFM_Final.od
() Mew Worksheet E ®ang
e ACC AFM
ting Wo et
(@) Existi Q Workshe . I:‘?E Blank]
Location: | Sheet5!5A31 5] ACC DEAMS GL
o B @ik
Choose whether you want to analyze multiple tables D ACC ISOF
[] Add this data to the Data Model B g
D ACC Overall_ODL Thl_ODL.od
oK Cancel B o v
A
Browse for More. Qpen Cancel

8/21/2023 Footer 19



P

.TEK 4 - Create Pivot Table

. PivotTable Fields NS y ] .
semtene | S Let’s create our Pivot
Search T Filters
] Aal/ADSN
SR A B C D
B comremmece 1] Yelne:
[ o Adv 2 Cost Center/RCCC -~ Sum of Dir Total Auth Sum of Dir GrObl Sum of Dir UnObl Total
Sornes 5 | - - -
SR 4 100112 650,200.00 650,962.67 (762.67)
Do W Courms 5 |101J1B 211,900.00 209,880.82 2,019.18
D or s BT 6 101J1E 49,800.00 49,605.97 194,03
b 7 |101J1G 317,700.00 286,200.43 31,499.57
D prcenn 8 101423 936,200.00 934,321.27 1,878.73
9 101424 579,500.00 579,770.73 (270.73)
oo 10 101425 655,500.00 651,771.28 3,728.72
Oooman | 11 300000 11,513,400.00 6,415,606.09 5,097,793.91
e o 12 300001 11,657,400.00 3,426,908.92 8,230,491.08
O 7 e 13 300003 935,400.00 940,293.78 (4,893.78)
SR 14 300007 1,000.00 1,000.00 -
et iy 15 30010A - 1,653.94 (1,653.94)
[ PEC Legacy 16 | 34FIG1 - - -

| Sl 17 1300120 - 81,511.77 (81,511.77)
o ae R 18 3001A0 - 3,970.17 (3,970.17)
gz:\ueme zz:jg:;;;mm : 10 12001 0N - ? 74R RO {? 74A 5OY
? Svj‘ij sum : Oir Unobb‘l Total =

8/21/2023

Footer
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4 - Create Pivot Table

Problem: We want to hide RCCCs that have SO dollars in all fields.

8/21/2023

Footer

Values

Cost Center/RCCC ~ |Sum of Dir Total Auth Sum of Dir GrObl Sum of Dir UnObl Total
101J12 650,200.00 650,962.67 (762.67)
101J1B 211,900.00 209,880.82 2,019.18
101J1E 49,800.00 49,605.97 194.03
101J1G 317,700.00 286,200.43 31,499.57
101123 936,200.00 934,321.27 1,878.73
101124 579,500.00 579,770.73 (270.73)
101125 655,500.00 651,771.28 3,728.72
300000 11,513,400.00 6,415,606.09 5,097,793.91
300001 11,657,400.00 3,426,908.92 8,230,491.08
300003 935,400.00 940,293.78 (4,893.78)
300007 1,000.00 1,000.00 -

30010A - 1,653.94 (1,653.94)
34FIG1 - - -

21



ATEKSOUTH 4 - Create Pivot Table
S,

Solution Step 1: Create a Helper Calculated fields

Insert Calculated Field ? X
PivotTable Analyze Design Neme: | Helper (TotalAuh, GrObs) vl ety
Formula: | ='Dir Total Auth'+'Dir Grobl' Delete
‘DD' E:H [:] { o | |
Dﬁj X D d]] Fields:
. . Dir Avail Auth
Fields, Items, PivotChar Dir Commits 8
& SEtS w Dir GrComm
Dir Sub Auth
Dir Total Auth
Calculated Field... Dir UnCormm v
Dir UnComm Total v
OK Close

8/21/2023 Footer 22
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4 - Create Pivot Table

Solution Step 2: Use a Value Filter

8/21/2023

sort Ato Z

Sort Zto A

More Sort Options..

Label Filters

Value Filters

Search

-[v](Select All)
vl101012
¥ 10118
-[v]101J1E
¥ 1011G
v 101J23
v 101)24
-[¥]101J25
-[v]300000
-[v]300001
-[¥]300003

1 Values

2 Cost Center/RCCC ~ |Sum of Dir Total Auth Sum of Dir GrObl Sum of Dir UnObl Totall Sum of Helper (TotalAuth, GrObsl)
A - - -

z

A

0.00 650,962.67 (762.67) 1,301,162.67
0.00 209,880.82 2,019.18 421,780.82
0.00 49,605.97 194.03 99,405.97
0.00 286,200.43 31,499.57 603,900.43
0.00 934,321.27 1,878.73 1,870,521.27
y 0.00 579,770.73 (270.73) 1,159,270.73
"o mrammaas 3,728.72 1,307,271.28
? ? 5,097,793.91 17,929,006.09
£ Equals.. 8,230,491.08 15,084,308.92
a (4,893.78) 1,875,693.78
Does Not Equal.., - 2,000.00
(1,653.94) 1,653.94

Greater Than...
Greater Than Or Equal To... (81,511.77) 81,511.77
Less Than.. (3,970.17) 3,970.17
B (2,746.59) 2,746.59
Less Than Cr Equal To... - 8,000.00
(1,729.61) 1,729.61
Between.. (355,057.44) 375,057.44
Not Between. . 2,582,882.18 4,426,317.82
- 54.300.00 54.300.00

Footer
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ATEKSOUTH 4 - Create Pivot Table

Solution Step 2: Use a Value Filter

Value Filter (Cost Center/RCCCO)

Showe iterms for which

Sum of Dir Total Auth ~ | does not equal W

Sum of Dir Total Auth
Sum of Dir GrOhkl o - |
Sum of Dir UnObl Total ance
Sum of Helper (TotalAuth, GrObsl) 1,729.61 (L,729.61)

24

Footer
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4 - Create Pivot Table

Cost Center/RCCC -7
101J12
101J1B
101J1E
101J1G
101)23
101)24
101)25
300000
300001
300003
300007
30010A

Values

Sum of Dir Total Auth Sum of Dir GrObl Sum of Dir UnObl Total Sum of Helper (TotalAuth, GrObsl)

300120

8/21/2023

650,200.00
211,900.00
49,800.00
317,700.00
936,200.00
579,500.00
655,500.00
11,513,400.00
11,657,400.00
935,400.00
1,000.00

650,962.67
209,880.82
49,605.97
286,200.43
934,321.27
579,770.73
651,771.28
6,415,606.09
3.426,908.92
940,293.78
1,000.00
1,653.94
81,511.77

Footer

(762.67)
2,019.18
194.03
31,499.57
1,878.73
(270.73)
3,728.72
5,097,793.91
8,230,491.08
(4,893.78)
(1,653.94)
(81,511.77)

1,301,162.67
421,780.82
99,405.97
603,900.43
1,870,521.27
1,159,270.73
1,307,271.28
17,929,006.09
15,084,308.92
1,875,693.78
2,000.00
1,653.94
81,511.77

25
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4 - Create Pivot Table

Problem: If we want to also manually filter on RCCC, the value filter

Values

Sot Ato Z

1
2
2l s
2l

Sort Zto A

Cost Center/RCCC |7 |Sum of Dir Total /

More Sort Options..

Label Filters

Value Filters

-T2
-L1101118
Choule
-L11011G
o2z
-[1101)24
-L110125
[¥1300000
-I»1200001
[¥300002
-¥1300007

8/21/2023

(
(
(
(
(
? Clear Filter From "Cost Center/RCCC" [
(
(
(
(
(

~[W (Select All)

)\Ovv

is removed.

A B

Values

Cost Center/RCCC ¥ |Sum of Dir Total Auth Sum of Dir GrObl Sum of Dir UnObl Total

of Helper {TotalAuth, GrObsl)

1

2

21 sortAtoz -
il

0.00
Sort Zto A 0.00
More Sort Options... 0.00
0.00
? Clear Filter From "C gl Center/RCCC! _
Label Filters S -
Yalue Filters > :
Search p -
E -] (Select All} ~ 0.00
)
110112 0.00
[ 110118 0.00

Footer

6,415,606.09
3,426,908.92
940,293.78
1,000.00
1,653.94
81,511.77

3,970.17 |
2,746.59
4,000.00
1,729.61
365,057.44
921,717.82

5,097,793.91
8,230,491.08
(4,893.78)

(1,653.94)
(81,511.77)
(3,970.17)
(2,746.59)
(1,729.61)
(355,057.44)
2,582,882.18

cA AN AN

17,929,006.09
15,084,308.92
1,875,693.78
2,000.00
1,653.94
81,511.77
3,970.17
2,746.59
8,000.00
1,729.61
375,057.44
4,426,317.82

cA AN AN




ATEKSOUTH

v B
)

, B

+
ihl

el

Search the menus

Copy

Format Cells...
Number Format...
Refresh

Sort

Remowe "Sum of Dir GrObl"

Summarize Values By
Show Values As
Show Details

Value Field Settings...

PivotTable Options...

: Hide Field List
¥

Options

4 - Create Pivot Table
S —

Solution: Turn on ‘Allow multiple filters per field’ in Pivot Table

PivatTable Options
divotTable Mame: | PivotTable

Layout & Format  Totals & Filters

Grand Totals
Shaow grand totals for rows
Show grand totals for columns
Filters

Subtotal filtered page iterns
EAIIOW multiple filters per field:

Sorting

lUse Custom Lists when sorting

Display  Printing Data Alt Text

**To get to Pivot Table Options, Right-Click Anywhere inside the pivot table.**

8/21/2023
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ATEKSOUTH 4 - Create Pivot Table
S,

Problem:

You'd like to quickly and easily switch (filter)
between the different BAs and Commodities.




ATEKSOUTH 4 - Create Pivot Table
S,

Solution: Use Slicers
* PivotTable Analyze Tab > Insert Slicer
e Check mark BA and Commodity > Click Ok

View Automate Developer Add-ins Help  Acrobat Power Pivot PivotTable Analyze Design
— = F N F=1EE=] =] f} [K%
2= B [ io N 2 i
Insert  Insert Refresh Change Data Clear Select Move Fields, Items,

Slicer Timeline > Source ¥ v v PivotTable & Sets v
Filter Data Actions Calculations
ADaily SOFyPam's Daily Status v = Insert Slicers ? X
[] aaizapsn ~
) £ [ appropriation | I K L
- | | |
InObl Total Sum of Helper (TotalAuth, Commodity
(762.67) 1,301 [] Cost Center/RCce
2,019.18 421 [] Dir Adv
194.03 98 [ biraep
31,499.57 603 [ oir AU
1,878.73 1,870 o
[ Dir Avail Auth
(270.73) 1,154 i }
3,728.72 1,307 I:‘ Dir Commits
097,793.91 17,92¢ [ pirGicomm
15,084 [ bir Grobl
(4,893.78) 1,875 [ ] Dir Sub Auth
- 2 [ Dir Total Auth
{1,653.94) ! [ Dir UnComm Awail
(81,511.77)| 81 .
[] pir unComm Total
(3,970.17) C g e v
RrEE] ;

Footer
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TEKSOUTH

4 - Create Pivot Table

Formatting Slicers

* When selected, Slicer menus on the ribbon show that allow you to adjust their

Pam's Dally Status of Funds.xisx ¥ > vearan
File Home Insert Page Layout Formulas Data Review View Automate Developer Add-ins Help Acrobat Power Pivot E
Slicer Caption: E@ ———E==] === |:I|_—| L_lj I:’a |:'|:| @ AB El;[lColumns: ! : I:D Height: 2.76"
Commeodity Report E==l E=5 == == BE== == : Bring Send  Selection Align {Height: 026" A= .
[] Sticer Settings | Connections “1' Forward v Backward ~ v TIWidth: 158 [ = Width: 2
Slicer Slicer Styles Arrange Buttons Size ]
AutoSave [E ") v G' = = @ @A CA\Daily SOF\Pam's Daily Status ~ =
Commodity - k
A | B c D | E F G | | K L
1 Values BA = 2
2 | Cost Center/RCCC -¥ Sum of Dir Total Auth Sum of Dir GrObl Sum of Dir UnObl Total Sum of Helper (TotalAuth, GrObsl)
3 10u12 650,200.00 650,962.67 (762.67) 1,301,162.67 [ _J
4 101)1B 211,900.00 209,880.82 2,019.18 421,780.82 [ 00 o Commodity © %= o
5 |10L1E 49,800.00 49,605.97 194.03 99,405.97
6 10111G 317,700.00 286,200.43 31,499.57 603,900.43 01
7 101J23 936,200.00 934,321.27 1,878.73 1,870,521.27 @
8 101124 579,500.00 579,770.73 (270.73) 1,159,270.73
9 101J25 655,500.00 651,771.28 3,728.72 1,307,271.28
10300000 11,513,400.00  6,415,606.09 5,097,793.91 17,929,006.09 () S
11 |300001 11,657,400.00  3,426,908.92 15,084,308.92
12 |300003 935,400.00 940,293.78 (4,893.78) 1,875,693.78
13 300007 1,000.00 1,000.00 o 2,000.00
14300104 - 1,653.94 (1,653.54) 1,653.94
15 300120 - 81,511.77 (81,511.77) 81,511.77 Supplies
16 3001A0 - 3,970.17 (3,970.17) 3,970.17 ’W
17 [3001D0 - 2,746.59 (2,746.59) 2,746.59 N o N

o nnn nn

Footer




TEKSOUTH

4 - Create Pivot Table

Formatting Slicers

File Home Insert Page Layout Formulas Data Review View Automate Developer Add-ins Help Acrobat Power Pivot Slicer

i ion: = | = e Columns: 5 8 . -
Slicer Caption: %\ —— == === I:||_-| L_Ij I:'—lb LI_:I @ 4& EI] ) ‘; I_[l Height: 1.1" .
Commodity . == E== & _ o IlHeight: 02e"  C

eport el eV e B e FEE Be=| = Bring Send  Selection Align — ~ | Blwidth: 564" ~
[E] Slicer Settings = Connections Forward ¥ Backward v Pane h = Width: |1.07" . = ICEN:]D. v
Slicer Slicer Styles Arrange Buttons Size N
AutoSave B e & = = © ©7 C\Dally SOF\Pam’s Daily Status ~ ¥
Commodity - I
A , B , C D , E | F G | H I | K L M
A4

1 pa ¥= 57 || Commodity = 57
2
3_ l H 00 I I CivPay H Comm “ Equipment H Other Cont... H Printing I
:_ l 01 H 04 I I Real Property H Supplies “ Trans Prop... H Travel H (blank) I
6 o O
7 Values
& Cost Center/RCCC | Sum of Dir Total Auth Sum of Dir GrObl Sum of Dir UnObl Total Sum of Helper (TotalAuth, GrObsl)
9 101112 650,200.00 650,962.67 {762.67) 1,301,162.67
10 101J1B 211,900.00 209,880.82 2,019.18 421,780.82
11 10LJ1E 49,800.00 49,605.97 194.03 99,405.97
12 10111G 317,700.00 286,200.43 31,499.57 603,900.43
13 101J23 936,200.00 934,321.27 1,878.73 1,870,521.27
14 /101J24 579,500.00 579,770.73 (270.73) 1,159,270.73

8/21/2023

**Keyboard Shortcut — New Tab = Ctl+ Left click the tab and drag **

Footer




ATEKSOUTH 4 - Create Pivot Table
T CCE—————SSSSSSS,

PivotTable Fields v Let’s duplicate the tab and make a new pivot report.

Ehesss Btk e Drag fields between areas
add to report: below

Search LT Fiters

] aazaDsn |-

p * Delete the slicers

1 commodity

Do * Remove everything but GrObl

[ pir AEP

EE::\E:H Auth 1 columns ° Add SyStem

[ Dir Commits

[ pir GrComm

Dir GrObl

[ Dir Sub Auth

[ Dir Total Auth

[[J bir UnComm Avail
D Dir UnComm Tot.

[ Dir UnObl Avail Sum ﬂf Dil’ GI’Obl

[ pir UnObl Total _
[ bir uco © 5 - T I
e Peiod D - ystem ota

[] FAD Ann Amt

SEYS—— DEAMS 40,220,515.49

[

O s Legacy 3,090,962.85

[T FY 4 Chan)

S Grand Total 43,311,478.34

[[] ©bject Class Title 3 Values
O Operating Entity
[] pEC DEAMS

D PEC legacy

] PEC Title

Period Date

[ Period Name
[] Post Date

[ sac

Sum of Dir GrObl v

8/21/2023 Footer 2



4 - Create Pivot Table

You can add values to a pivot more than once.

Values

Sum of Dir GrObl Sum of Dir GrObl2
40,220,515.49 _| 40,220,515.49
3,090,962.85 3,090,962.85
43,311,478.34 43,311,478.34

T Filters Il Columns
> Values v
System -
DEAMS
) Legacy
S S | |'Grand Total
System ~ | Sum of Dir Grohl -

Sum of Dir Grobl2

4

**Drag and drop Dir GrObl from the field list to the Values box again**

8/21/2023 Footer
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ATEKSOUTH

Summarization
Options

**Right Click within the
value to get this menu™**

8/21/2023

4 - Create Pivot Table

BI=0vAviivPBAY

Search the menus

@

[3

Copy

Eormat Cells...

Number Format...

Refresh

Sort >

Remaove "Sum of Dir Grobl[2"

Summarize Values By >
Show Values As >
Show Details

Value Field Settings...

PivotTable Options...

Hide Field List

Values
System | - [Sum of Dir GrObl Count of Dir GrObI2 Sum of Lav wivrwsie |
DEAMS 40,220,515.49 17,257.00 | 40,27~ """~ :
Legacy 3,090,962.85 1,022.00 3,0
Grand Total| 43,311,478.34 18,279.00 43,3
Footer

Sum
Count
Average
Max

Min

Product

Mare Options...

34
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Calculation
Options

**Right Click within the
value to get this menu™**

8/21/2023

4 - Create Pivot Table
S —

System -
DEAMS
Legacy
Grand Total

Values

Sum of Dir GrObl Count of Dir GrObl2 Sum of Dir ¢ B I =30 A v

40,220,515.49
3,090,962.85
43,311,478.34

Calibi ~11 ~A A $ vY% 9

17,257.00 | 40,220,515.49 |

1,022.00
18,279.00

3,090,
43,3114

Footer

Search the menus

(B Copy
Format Cells...

Number Format...
I_-‘é Refresh
Sort >

X Remove "Sum af Dir GrObl2"

v

Summarize Values By

Show Values As >
*= Show Details
I4# Value Field Settings...

PivotTable Cptions...

Hide Field List

v No Calculation
% of Grand Total
% of Column Total
% of Row Total
% COf...

% of Parent Row Taotal




ATEKSOUTH 4 - Create Pivot Table

Values
System | ~ |Sum of Dir GrObl Count of Dir GrObl2 Sum of Dir GrObl2
DEAMS 40,220,515.49 17,257.00 92.86%|
|Legacy 3,090,962.85 1,022.00 7.14%
Grand Total| 43,311,478.34 18,279.00 100.00%

8/21/2023

Footer 36
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Values I
R o 7- t / Period Date ~ |Sum of Dir GrObl Sum o Calibri v11 v A" A" § ~ 9% 9
unn/ng 0 a S 10/31/2021]  2,283,812.02 2B IS A YR8
11/30/2021|  1,567,010.68 1,004 u1u.00 swem)
12/31/2021 3,829,679.63 e —
1/31/2022|  3,243,600.20 3 Search the menus
2/28/2022 2,091,199.38 2
@ copy
3/31/2022 3,175,328.94 3
4/30/2022|  2,002,909.74 2 [H] Format Cels..
5/31/2022 7,048,713.97 7 Number F "
6/30/2022|  2,756,492.85 2 Hmber Formel..
7/31/2022 4,846,444.05 4 [5 Refresh
8/31/2022 3,996,311.94 3
° 4996,
SWap OUt SyStem for 9/30/2022 6,503,005.41 6 Sort >
Period Date 10/31/2022 (8,886.16) X Remoye "Sum of Dir Grob 2"
11/30/2022 {29,113.60)
H 12/31/2022 4,969.29 Summarize Yalues By >
° ,
Tu mn Dlr GrObl 2 baCk to a Grand Total 43,311,478.34 43 ——— 5 v ol
ow Values As Nao C I
SU m No Lalculation
*= Show Detalls % of Grand Total
IZ Value Field Settings... % of Column Total
PivotTable Options... % of Row Total

Hide Field List % Of.
% of Parent Row Total
% of Parent Column Total
% of Parent Total...
Difference From...
% Difference From...
Running Total In...

% Running Total In...

* Right C/iCk Within the Rank Smallest to Largest..,
Va/ue to get this menu** Rank Largest to Smallest.

Index

More Options...

8/21/2023 Footer
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Running Total

Values
Period Date ~ |Sum of Dir GrObl Sum of Dir GrObl2 Sum of Dir GrObl3
10/31/2021|  2,283,812.02 2,283,812.02 5.27%
11/30/2021|  1,567,010.68 3,850,822.70 3.62%
Show Values As (Sum of Dir .. 12/31/2021|  3,829,679.63 7,680,502.33 8.84%
1/31/2022|  3,243,600.20  10,924,102.53 7.49%
Calculation: Running Total In 2/28/2022|  2,091,199.38  13,015301.91 4.83%
Bl st [Tori =T e 3/31/2022|  3,175,328.94 16,190,630.85 7.33%
aK Cancel 4/30/2022|  2,002,909.74  18,193,540.59 4.62%
5/31/2022|  7,048,713.97  25,242,254.56 16.27%
6/30/2022| 2,756492.85  27,998,747.41 6.36%
7/31/2022|  4,846444.05  32,845191.46 11.19%
8/31/2022| 3,996,311.94  36,841,503.40 9,23%
9/30/2022|  6,503,005.41  43,344,508.81 15.01%
10/31/2022 (8,886.16)  43,335,622.65 -0.02%
11/30/2022 (29,113.60)  43,306,509.05 -0.07%
12/31/2022 4,969.29  43311,478.34 0.01%
Grand Total 43,311,478.34 100.00%

8/21/2023

Footer
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Objective 5

Create a Pivot Chart




ATEKSOUTH 4 - Create Pivot Table
S,

Insert a Pivot Chart

Insert Chart ? X

Al Charts

ey [l A (17 JaB 00 50

Column

AN

line Clustered Column

o coomomn
e 45,000,00000
soomomom

Bar smamane
o0 o000

PivotTable Analyze Design

7 0 22 g 5

Fields, Items, PivotChart Recommended
& Sets v PivotTables

2 sounns
Area 2 omom

XY (Scatter) o | | ’ |
| |
24

seen0000

Map b

—

Stock

Surface
Radar
Calculations Tools Treemap
Sunburst
Histogram

Box & Whisker
Waterfall

Funnel

FIAIE=FOHEBRPRECRSMORXE

Combo

| oK | | Cancel |

**|f you don’t see PivotTable Analyze tab, make sure you are clicked
inside the Pivot Table**

40
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S,

This Pivot Chart doesn’t make much sense...lets change the values we
are looking at.

Sum of Dir Grobl Sum of Cir Groblz - Sum of bir (5robl 3

50,000,000.00
45,000,000.00

40,000,000.00

35,000,000.00

30,000,000.00

25,000,000.00 Walues

20,000,000.00 W sum of Dir Grobl

15,000,000.00

10,000,000.00 W sum of Dir Grobl2
2,000,000.00 ‘ ‘ ‘ I I I W Sum of Dir Grobl3

il 0 | |

(5,000,000.00)

10/31/2021
11/30/2021 =
12/31/2021 ===
173172022 =—
2/28/2022
3/31/2022
443072022
5/31/2022
6/30/2022
7/31/2022
8/31/2022
9/30/2022
1043172022
1173042022
12/31/2022

Period Date -

8/21/2023 Footer 41
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PivotChart Fields vooX
Ch fields t Drag fields between areas
oose fields to S

add to report

e Remove from the Pivot Table Values:
e ‘Sum of Dir GrObl” and ‘Sum of Dir GrObl3’

Search P Filters

[ AAIZADSN

O Appropriation
[Jea

1 commodity

[ Cost Center/RCCC
[ bir Adv

Dir AEP

[ oir AEU

Dir Avail Auth
Dir Commits

[ pir Grcomm

Dir GrObl

[ Dir sub Auth

[ bir Total Auth

[ Dir unComm Avail
[ bir UnComm Total
[ Dir UnObl Avail
[ Dir UnObl Total
[ bir uoo

[ eeic

[] FAD Ann Amt

[[] FAD Qtr Amt Total
e

[ Fund

1 v c4 Chan)

[ Helper (TotalAuth, GrO.
[[] Object Class

[C] Object Class Title
[ Operating Entity
[ PEC DEAMS

[ PEC tegacy

[ PeC Title

Period Date

[ period Name

[ Post Date
[Jsac

[ source

[ system

8/21/2023

Asis (Categories)

Period Date

Legend (Series)
2 Values

2 Values

Sum of Dir GrObl2
Sum of Dir Avail Auth
Sum of Dir Commits

Sum of Dir AEP

» Add to the Pivot Table Values:
e Dir Avail Auth, Dir Commits, Dir AEP

* Turn all values into running totals

Period Date ~
10/31/2021
11/30/2021
12/31/2021

1/31/2022
2/28/2022
3/31/2022
4/30/2022
5/31/2022
6/30/2022
7/31/2022
8/31/2022
9/30/2022
10/31/2022
11/30/2022
12/31/2022

Zrmnd Takal

Values
Sum of Dir GrObl2 Sum of Dir Avail Auth Sum of Dir Commits

Sum of Dir AEP

2,283,812.02

3,850,822.70

7,680,502.33
10,924,102.53
13,015,301.91
16,190,630.85
18,193,540.59
25,242,254.56
27,998,747.41
32,845,191.46
36,841,503.40
43,344,508.81
43,335,622.65
43,306,509.05
43,311,478.34

Footer

5,568,900.00

6,536,900.00

9,599,000.00
15,099,000.00
16,989,900.00
19,357,800.00
22,157,800.00
33,061,100.00
44,450,700.00
46,141,500.00
44,480,000.00
43,355,130.00
43,355,130.00
43,355,130.00
43,355,130.00

618,213.00
1,209,920.00
1,276,552.00
1,295,578.00
1,857,234.00
2,589,792.00
3,446,068.00
2,515,420.00
4,334,327.00
3,081,453.00

3,112,271.00 |

14.00
(22,363.00)
(37,435.00)
(37,435.00)

(2,478.67)
573,759.11
3,800,363.71
7,169,282.10
8,769,917.86
11,786,451.95
13,615,709.70
16,171,522.96
19,568,906.22
22,287,052.73
25,525,248.99
29,755,440.50
32,130,889.22
33,003,608.11
33,150,597.96

42
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S,

* Change Chart Type to Combo Chart

* Sum of Dir GrObl2 = Stacked Column e r x
Al Charts
* Sum of Dir Avail Auth = Line 5 s ;
. . o o (i i R 2
e Sum of Dir Commits = Stacked Column i < -
B Line Custom Combination
1 -— ® Pie 50,000,000.00
* Sum of Dir AEP = Area o o
000,000 I
@ Area 1
|22 X (Scatter) e 1 m of i
@ Map 20,000,000.00 m of Cir
m of Cir Grobl2
||‘]6f| Stock 10,000,600,00 A m of Cir Avail Auth
S
; H ﬁ Treema (10,000oooQ@\W&:‘)#;’\@i&@id@i“@i*@i"\q‘é\p
PivotChart Analyze Design Format i TS E T
@ Sunburst Choose the chart type and axis for your data series:
|[[|:l Histogram Series Mame Chart Type Secondary s
I B Box & Whisker B sum of Dir Grobi2 Stacked Column - O
L [P waterfal
_— I I = Fuhthel I Sum of Dir Avail Auth Line v O
MDVE m aize I sum of Dir Commits Stacked Column ~ O
Chart Sum of Dir AP . m
Location
oK Cancel

**If you don’t see PivotChart Design tab, make sure you have the
Pivot Chart selected™**

43
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Now we’ll clean this Pivot Chart up

Sum of Dir Grobl2 . Sum of Dir Avail Auth Sum of Dir Commits Sum of Dir AEP

h

r~
1.

50,000,000.00

40,000,000.00

30,000,000.00

alues
Sum of Dir AEP
) 20,000,000.00 e Sum of Dir Commits C

. sum of Dir Grobl2
w51 of Dir Awvail Auth

10,000,000.00 I

Y D>

Y D ar o Ay ar i
'b\\qu ":Q\"S) '999 'b\’\% Ui \ %\’\Q ":Q\Q DS
RS GIRN GR EN A E G SR A GE \

{10,000,000.00])

v
S oY

g
Y
CSEES

.
& &

Period Date ~
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S,

* Rename values
e Remove the 2 from Sum of Dir GrObl2
e Remove ‘Sum of’ from all of them

8/21/2023

Values
Period Date -~ Sum of Dir GrObl Sum of Dir Avail Auth Sum of Dir Commits Sum of Dir AEP
10/31/2021 2,283,812.02 5,568,900.00 618,213.00 (2,478.67)
11/30/2021 3,850,822.70 6,536,900.00 1,209,920.00 573,759.11
12/31/2021 7,680.502.33 9.599.000.00 1.276.552.00 3.800.363.71
1/31/2022 10,97 Find and Replace ? X
2/28/2022 13,01
3/31/2022 16,19 Find  Replace
4/30/2022 18,1¢ Find what sum of v Format.. -~
5/31/2022 25,24
6/30/2022 27,99 Replacewith v Format.. ~
7/31/2022 3284 i [sheet v | [matchcase
8/31/2022 36,84 D hatch entire cell contents
9/30/2022 43,34 <Searchi ByRows v
10/31/2022 43,33 Lookin: |Formulas v Options <=
11/30/2022 43,3(
12/31/2022 43*3] Replace Fird All Eind Mext Close
Grand Total

Footer
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S,

e Hide field buttons

PivotChart Analyze Design Format

= | i

Field Field
List |Buttons ¥

Sho ' Show Report Filter Field Buttons

v Show Legend Field Buttons
Show Axis Field Buttons

v
v Show Value Field Buttons
v Show Expand/Collapse Entire Field Buttons

Hide All

**If you don’t see PivotChart Analyze tab, make sure you have the Pivot Chart selected**

46
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* Add a Chart Title: Daily Status of Funds

O O O
20,000,000.00 . Chart Elements
Axes
[0 Axis Titles
40,000,000.00 [l Chart Title
Above Chart
[0 Data Labels
[ Data Table Centered Overlay
[0 Error Bars Maore Options...
30,000,000.00 o
Gridlines
Legend
Sum of Dir AEP & 9
[0 Trendline
e Sum of Dir Commits
O 20,000,000.00 le) [ up/Down Bars
s Sum of Oir Grobl
s ST O O Avail Auth
10,000,000.00 I |
™y "y %% 43 3 Nz 43 " g Nz 43 T e ) s
4% AR A% b oV b b b " % b oV L A% an
Q ] N ) 5} N ] 8] & 5} N N )
SN LN SN LR ARSI S SR LN CRR LN G SN
SRS GG RN G LRI N RS I NS GG IR G
" Y Y b Y
(10,000,000.00)
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S,

Format Axis v

Axis Options v  Text Options

e Set Minimum Value to O O O il - —

e Scale Axis to thousands

50,000,000-00
Delete v Axis Options

e Bounds

|s_—3| Reset to Match Style Minimurm oo '
40,000,00 B

A Font... Maximum 5.0E7

{1 change Chart T o

ange Chart Type...
Major 5.0E6

30,000,00

Eﬁ Select Data.. Minor 1.0E6 Auto

E] Horizontal axis crosses

. o Aut ti
20,000,00 Add Minor Gridlines ® Automatic

O Axis value

O Maximum axis value
“Fehyie
10,000,00
g g

\g
3
:

2

Show display units label on chart
[] Logarithmic scale

[] Values in reverse order
s s " 3!
S St \'WS;L '19% 'WS;L \'19% > Tick Marks
> oY "y Y
IR G S GRS G > Labels

{10,000,000.00)
o o

| > Number

48
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S —

* Design the chart how you see fit

&)

Change| 05 —eeowr
Colors v
Colorful z
EENTER
ENEEER
PivotChart Analyze Design Format | . .... -
= | ENTEHEN
Monochromatic
HEEN B
. HHEN
 HERN g

HE y

0.
HERRE o
- S e

49
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S,

Daily Status of Funds

- 50,000.00
=
=
"
S 45,000.00
o
=
'_
40,000,00
35,000.00
20,000.00
25,000.00 Sum of Dir AEP
) m Sum of Dir Commits
20,000.00 s Sum of Oir Grobl
s S of Dir Avail Auth
15,000.00
10,000.00
5,000.00 I
"y "y "y N 3 e e " . s e e . g s
V o 4 b o s o W W s V oV 3
%) S 8] ) L s} ) N £ .} 3 %) S %]
SUSIEAGIEN RN AN LGNS (RN GRS SN RN CRIES N LR (R
KGRI RN G S I I SR I G G G GO GO
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S,

Office 365 & 2019 allows you to insert a Pivot Chart directly — without
needing to be tied to a Pivot Table

Import Data ? X

Select how you want to wiew this data in your workbaook,

1 O 1able

O PivotTable Report

D O Cnly Create Connection
Where do you want to put the data?

O Existing worksheet:

=$A5T +
@ Mew worksheat
D Add this data to the Data Model
Properties., - oK Cancel

51

Footer
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Refresh Data




ATEKSOUTH 6 — Refresh Data

5 Data View A .: \ + ; /
E Queries & Conne
B F

sting Refresh . Properties
iections All v [D\

Queries & Connections
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